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1
Product Description

The HP Compaq nx6130 Notebook PC offers advanced 
modularity, Intel® Pentium® M and Celeron® M processors, and 
extensive multimedia support.

HP Compaq nx6130 Notebook PC
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Product Description
1.1 Features
■ The following processors are available, varying by 

notebook model:

❏ Intel Pentium M 2.13-, 2.00-, 1.86-, 1.73-, 1.60-, or 
1.30-GHz processor, 

❏ Intel Celeron M 1.5- or 1.4-GHz

■ The following displays are available, varying by 
notebook model:

❏ 15.0-inch, SXGA+WVA, TFT (1400 × 1050) with over 
16.8 million colors

❏ 15.0-inch, XGA, TFT (1024 × 768) with over 16.8 million 
colors

❏ 14.1-inch, XGA, TFT (1024 × 768) with over 16.8 million 
colors

■ 80-, 60-, or 40-GB high-capacity hard drive, varying by 
notebook model

■ 256-MB DDR2 synchronous DRAM (SDRAM) at 533 MHz, 
expandable to 2.0 GB

■ Microsoft® Windows® XP Home Edition SP2, Windows XP 
Professional SP2, or FreeDOS, varying by notebook model

■ Full-size Windows keyboard with embedded numeric keypad

■ TouchPad pointing device, including a dedicated vertical 
scroll region

■ Integrated 10/100/1000 PCI-based Ethernet local area 
network (LAN) network interface card (NIC) with RJ-45 jack

■ Integrated high-speed 56K modem with RJ-11 jack
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Product Description
■ Integrated wireless support for Mini PCI IEEE 802.11b/g or 
802.11a/b/g WLAN device

■ Support for one or two Type II PC Card slots, with support 
for both 32-bit (CardBus) and 16-bit PC Cards, varying by 
notebook model

■ External 65-watt AC adapter with 3-wire power cord, varying 
by notebook model

■ 6-cell Li-Ion battery pack

■ Stereo speakers

■ Support for the following optical drives:

❏ DVD±RW and CD-RW Dual Layer Combo Drive, 
LightScribe

❏ DVD±RW and CD-RW Combo Drive

❏ DVD/CD-RW Combo Drive

❏ DVD-ROM drive

■ Universal Serial Bus ports (4)

■ PC Card slots (2)

■ Volume up, volume mute, and volume down buttons

■ Info Center button

■ Infrared port

■ 6-in-1 Digital Media Slot

■ Serial port

■ Parallel port

■ S-Video-out jack

■ Docking connector
Maintenance and Service Guide 1–3
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■ Connectors:

❏ Audio-out (headphone)

❏ Audio-in (microphone)

❏ Universal Serial Bus (USB) v. 2.0 (4 ports)

❏ Power

❏ External monitor

❏ RJ-11 (modem)

❏ RJ-45 (network)

❏ IEEE 1394

❏ Travel battery

❏ Infrared

❏ Digital Media Slot

❏ Parallel port

❏ S-Video-out

❏ Docking connector

❏ Serial port

1.2 Resetting the Notebook
If the notebook you are servicing has an unknown password, 
follow these steps to clear the password. These steps also 
clear CMOS:

1. Prepare the notebook for disassembly (refer to Section 6.3, 
“Preparing the Notebook for Disassembly,” for more 
information).

2. Remove the real-time clock (RTC) battery (refer to
Section 6.17, “RTC Battery,” for more information on 
removing and replacing the RTC battery).
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Product Description
3. Wait approximately 5 minutes.

4. Replace the RTC battery and reassemble the notebook.

5. Connect AC power to the notebook. Do not reinsert any 
battery packs at this time.

6. Turn on the notebook.

All passwords and all CMOS settings have been cleared.

1.3 Power Management
The notebook comes with power management features that 
extend battery operating time and conserve power. The 
notebook supports the following power management features:

■ Standby

■ Hibernation

■ Setting customization by the user

■ Hotkeys for setting the level of performance

■ Battery calibration

■ Lid switch standby/resume

■ Power/standby button

■ Advanced Configuration and Power Management (ACPM) 
compliance
Maintenance and Service Guide 1–5
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1.4 External Components
The external components on the front of the notebook are shown 
below and described in Table 1-1.

Front Components

Table 1-1

Front Components

Item Component Function

1 Infrared port Provides wireless communication between 
the notebook and an optional 
IrDA-compliant device.

2 Stereo speakers (2) Produce stereo sound.

3 Display release latch Opens the notebook.

4 Wireless light On: an integrated wireless device has been 
enabled.

5 Power/standby light ■ Green: The notebook is on.

■ Blinking green: The notebook is in 
standby mode.

■ Off: The notebook is off or in hibernation.
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6 Battery light ■ Amber: A battery pack is charging.

■ Green: A battery pack is close to full 
charge capacity.

■ Blinking amber: A battery pack that is the 
only available power source has reached 
a low-battery condition. When the battery 
reaches a critical low-battery condition, 
the battery light begins blinking more 
quickly.

■ Off: If the notebook is connected to an 
external power source, the light is turned 
off when all batteries in the notebook are 
fully charged. If the notebook is not 
connected to an external power source, 
the light is turned off until the battery 
reaches a low-battery condition.

7 Integrated Drive 
Electronics (IDE) drive 
light

Blinking: The hard drive or optical drive is 
being accessed.

8 6-in-1 Digital 
Media Slot

Supports 6 optional digital memory card 
formats: SD (Secure Digital) Memory Card, 
MultiMediaCard, Memory Stick, Memory 
Stick Pro, SmartMedia, and xD-Picture 
Card.

9 6-in-1 Digital Media 
Slot light

On: A digital memory card is being 
accessed.

Table 1-1

Front Components (Continued)

Item Component Function
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The external components on the right side of the notebook are 
shown below and described in Table 1-2.

Right-Side Components
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Table 1-2

Right-Side Components

Item Component Function

1 Audio-out 
(headphone) jack

Connects optional headphones or powered 
stereo speakers. Also connects the audio 
function of an audio/video device such as 
a television or VCR.

2 Audio-in 
(microphone) jack

Connects an optional monaural 
microphone.

3 USB ports (2) Connect USB 1.1- and 2.0-compliant 
devices to the notebook using a standard 
USB cable, or connect an optional External 
MultiBay II to the notebook. The MultiBay II 
must also be connected to an external 
power source.

4 Optical drive Supports an optical disc. The type of optical 
drive varies by model.

5 Serial port Connects an optional serial device.
Maintenance and Service Guide 1–9
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The external components on the left side of the notebook are 
shown below and described in Table 1-3.

Left-Side Components

Table 1-3

Left-Side Components

Item Component Function

1 USB ports (2) Connect USB 1.1- and 2.0-compliant 
devices to the notebook using a standard 
USB cable, or connect an optional External 
MultiBay II to the notebook. The MultiBay II 
must also be connected to an external 
power source.

2 External monitor port Connects an optional VGA external monitor 
or projector.
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3 Exhaust vent Provides airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as pillows, thick rugs, 
or clothing, to block airflow.

4 RJ-11 (modem) jack Connects the modem cable.

5 RJ-45 (network) jack Connects an optional network cable.

6 1394 port Connects an optional 1394a device such 
as a scanner, digital camera, or digital 
camcorder.

7 PC Card slots (2) Support an optional Type I, Type II, or 
Type III 32-bit (CardBus) or 16-bit PC Card.

8 PC Card eject buttons 
(2)

Eject an optional PC Card from the 
PC Card slot.

Table 1-3

Left-Side Components (Continued)

Item Component Function
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The external components on the rear panel of the notebook are 
shown below and described in Table 1-4.

Rear Panel Components
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Table 1-4

Rear Panel Components

Item Component Function

1 Security cable slot Attaches an optional security cable to the 
notebook.

Ä Security solutions are designed to 
act as deterrents. These deterrents 
may not prevent a product from 
being mishandled or stolen.

2 Battery bay Holds a battery pack.

3 Power connector Connects an AC adapter or an optional 
automobile or aircraft adapter.

4 Parallel port Connects an optional parallel device, such 
as an external diskette drive or a printer.

5 S-Video-out jack Connects an optional S-Video device, 
such as a television, VCR, camcorder, 
projector, or video capture card.
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The standard keyboard components of the notebook are shown 
below and described in Table 1-5.

Standard Keyboard Components
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Table 1-5

Standard Keyboard Components

Item Component Function

1 f1 to f12 keys (12) Perform system and application tasks. 
When combined with the fn key, several 
keys and buttons perform additional tasks 
as hotkeys.

2 caps lock key Enables caps lock and turns on the caps 
lock light.

3 fn key Executes frequently used system 
functions when pressed in combination 
with a function key or the esc key.

4 Windows logo key In Windows, displays the Windows 
Start menu.

5 Windows 
applications key

In Windows, displays a shortcut menu 
for items beneath the pointer.

6 Arrow keys Move the cursor around the screen.

7 Keypad keys (15) In Windows, can be used like the keys 
on an external numeric keypad.

8 num lock key Enables numeric lock, turns on the 
embedded numeric keypad, and turns 
on the num lock light.
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The notebook top components are shown below and described in 
Table 1-6.

Top Components, Part 1

Table 1-6

Top Components, Part 1

Item Component Function

1 Power/standby button When the notebook is:

■ Off, press to turn on the notebook.

■ On, briefly press to initiate hibernation.

■ In standby, briefly press to resume from 
standby.

■ In hibernation, briefly press to restore 
from hibernation.

If the system has stopped responding and 
Windows shutdown procedures cannot be 
used, press and hold for 5 seconds to turn 
off the notebook.
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2 Display lid switch ■  If the notebook is closed while on, 
turns off the display.

■ If the notebook is opened while in 
standby, turns on the notebook 
(resumes from standby).

3 Info Center button Launches Info Center.

4 Wireless button Turns the wireless functionality on or off, 
but does not create a wireless connection.

✎ To establish a wireless connection, 
a wireless network must already be 
set up.

5 Presentation mode 
button

Turns on Presentation mode.

6 Caps lock light On: caps lock is on.

7 Num lock light On: num lock or the numeric keypad is on.

Table 1-6

Top Components, Part 1 (Continued)

Item Component Function
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The notebook top components are continued below and described 
in Table 1-7.

Top Components, Part 2
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Table 1-7

Top Components, Part 2

Item Component Function

1 Volume mute button Mutes or restores system volume.

2 Volume down button Decreases system volume.

3 Volume up button Increases system volume.

4 TouchPad Moves the pointer and selects or activates 
items on the screen. Can be set to perform 
other mouse functions, such as scrolling, 
selecting, and double-clicking.

5 Left/right TouchPad 
buttons

Function like the left and right buttons on 
an external mouse.

6 TouchPad scroll zone Scrolls up or down.
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The external components on the bottom of the notebook are 
shown below and described in Table 1-8.

Bottom Components

Table 1-8

Bottom Components

Item Component Function

1 Primary battery bay Holds the primary battery pack.

2 Primary battery locking 
latch

Secures the primary battery pack into 
the battery bay.

3 Docking connector Connects the notebook to an optional 
docking device.
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4 Memory module 
compartment

Mini PCI compartment

Contains 1 memory slot that supports a 
replaceable memory module.

Holds an optional wireless LAN device.

Ä To prevent an unresponsive 
system and the display of a 
warning message, install only a 
Mini PCI device authorized for 
use in your notebook by the 
governmental agency that 
regulates wireless devices in your 
country. If you install a device and 
then receive a warning message, 
remove the device to restore 
notebook functionality. Then 
contact Customer Care.

5 Hard drive bay Holds the primary hard drive.

6 Primary battery release 
latch

Releases the primary battery pack from 
the battery bay.

7 Travel battery connector Connects an optional travel battery.

8 Fan Provides airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct fans. Do not allow a hard 
surface, such as a printer, or a 
soft surface, such as pillows, thick 
rugs, or clothing, to block airflow.

Table 1-8

Bottom Components (Continued)

Item Component Function
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1.5 Design Overview
This section presents a design overview of key parts and features 
of the notebook. Refer to Chapter 4, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 6, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ Audio

■ Display

■ Hard drive

■ Intel Pentium M and Celeron M processors

■ Keyboard and TouchPad

■ Memory module

■ Mini PCI communications devices

■ PC Card

Ä
CAUTION: To properly ventilate the notebook, allow at least a 7.6-cm 
(3-inch) clearance on the left and right sides of the notebook.

The notebook uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to be turned 
on automatically when high temperature conditions exist. These 
conditions are affected by high external temperatures, system 
power consumption, power management/battery conservation 
configurations, battery fast charging, and software applications. 
Exhaust air is displaced through the ventilation grill located on 
the left side of the notebook.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should repair 
this equipment. All troubleshooting and repair procedures are detailed 
to allow only subassembly-/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be 
used even when the operating system is not working or will not 
load. If the operating system is working, the notebook restarts the 
operating system after you exit Computer Setup.

✎ Pointing devices are not supported in Computer Setup; you 
must use the keyboard to navigate and make selections.

The menu tables later in this chapter provide an overview of 
Computer Setup options.
Maintenance and Service Guide 2–1



Troubleshooting
Accessing Computer Setup

The information and settings in Computer Setup are accessed 
from the File, Security, Tools, and Advanced menus.

1. Open Computer Setup by turning on or restarting the 
notebook. Press f10 while the F10 = Based Setup message is 
displayed in the lower-left corner of the screen.

❏ To change the language, press f2.

❏ To view navigation information, press f1.

❏ To return to the Computer Setup menu, press esc.

2. Select the File, Security, Tools, or Advanced menu.

3. To exit Computer Setup, choose one of the following:

❏ To exit without saving any changes, use the arrow keys to 
select File > Ignore changes and exit, and then follow 
the instructions on the screen.

❏ To exit and save all the settings you have entered, use the 
arrow keys to select File > Save changes and exit, and 
then follow the instructions on the screen.

Your preferences are set when you exit Computer Setup and take 
effect when the notebook restarts.

Computer Setup Defaults

To return all settings in Computer Setup to the values that were 
set at the factory:

1. Open Computer Setup by turning on or restarting the 
notebook. Press f10 while the F10 = Based Setup message is 
displayed in the lower-left corner of the screen.

❏ To change the language, press f2.

❏ To view navigation information, press f1.

2. Use the arrow keys to select File > Restore defaults.

3. Select the Restore Defaults check box.
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4. To confirm the restoration, press f10.

5. Select File > Save changes and exit, and then follow the 
instructions on the screen.

When the computer restarts, the factory settings are restored, and 
any identification information you have entered is saved.

Selecting from the File Menu

Table 2-1

File Menu

Select To Do This

System Information ■ View identification information about the notebook and any 
battery packs in the system.

■ View specification information about the processor, memory 
and cache size, video revision, keyboard controller version, 
and system ROM.

Save to floppy Save system configuration settings to a diskette.

Restore from floppy Restore system configuration settings from a 
diskette.

Restore defaults Replace configuration settings in Computer Setup 
with factory default settings. (Identification 
information is retained.)

Ignore changes and exit Cancel changes entered during the current 
session. Then exit and restart the notebook.

Save changes and exit Save changes entered during the current session. 
Then exit and restart the notebook. The changes 
you save are in effect when the notebook restarts.
Maintenance and Service Guide 2–3



Troubleshooting
Selecting from the Security Menu

Table 2-2

Security Menu

Select To Do This

Administrator password Enter, change, or delete an HP Administrator 
password.

Power-on password Enter, change, or delete a power-on password.

Password options ■ Enable/Disable stringent security.
■ Enable/Disable required password on restart.

DriveLock passwords Enable/disable DriveLock; change a DriveLock 
user or master password.

✎ DriveLock Settings are accessible only 
when you enter Computer Setup by turning 
on (not restarting) the notebook.

Smart Card Security Enable/disable power-on support for smart cards.

✎ This feature is supported by select smart 
card readers only.

Device security ■ Enable/Disable devices in the system.
■ Enable NIC for inclusion in MultiBoot.

System IDs Enter user-defined identification values.
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Selecting from the Tools Menu

Table 2-3

Tools Menu

Select To Do This

HDD Self Test options Run a quick or comprehensive self-test on any 
hard drive in the system.

Battery Information View information about any battery packs in the 
notebook.

Memory Check ■ Run a self-test on memory modules in the notebook.
■ View information about memory modules installed in the 

notebook.
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Selecting from the Advanced Menu

Table 2-4

Advanced Menu

Select To Do This

Language (or press f2) Change the Computer Setup language.

Boot options ■ Enable/Disable MultiBoot, which sets a startup sequence 
that can include most bootable devices and media in the 
system.

■ Set the boot order.

Device options ■ Swap the functions of the fn key and left ctrl key.
■ Enable/Disable multiple pointing devices at startup. (To set 

the notebook to support only a single, usually nonstandard, 
pointing device at startup, select Disable.)

■ Enable/Disable USB legacy support for a USB keyboard, 
mouse, and hub. When USB legacy support is enabled

❐ A USB keyboard, mouse, and hub work 
even when a Windows operating system 
is not loaded.

❐ The notebook starts from a bootable hard 
drive, diskette drive diskette, or CD, 
CD-RW, or DVD inserted into a drive 
connected by a USB connector to the 
notebook or to an optional docking 
device.

■ Select a parallel port mode: EPP (Enhanced Parallel Port), 
standard, bidirectional, or ECP (Enhanced Capabilities Port).

■ Enable/Disable all settings in the SpeedStep window. 
(When Disable is selected, the notebook runs in Battery 
Optimized mode.)
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Troubleshooting
2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview

Flowchart Description

2.1 “Flowchart 2.1—Initial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”

2.9 “Flowchart 2.9—No Operating System (OS) Loading”

2.10 “Flowchart 2.10—No OS Loading, Hard Drive, Part 1”

2.11 “Flowchart 2.11—No OS Loading, Hard Drive, Part 2”

2.12 “Flowchart 2.12—No OS Loading, Hard Drive, Part 3”

2.13 “Flowchart 2.13—No OS Loading, Diskette Drive”
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Flowchart Description

2.14 “Flowchart 2.14—No OS Loading, Optical Drive”

2.15 “Flowchart 2.15—No Audio, Part 1”

2.16 “Flowchart 2.16—No Audio, Part 2”

2.17 “Flowchart 2.17—Nonfunctioning Device”

2.18 “Flowchart 2.18—Nonfunctioning Keyboard”

2.19 “Flowchart 2.19—Nonfunctioning Pointing Device”

2.20 “Flowchart 2.20—No Network/Modem Connection”

Table 2-5

Troubleshooting Flowcharts Overview (Continued)
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Troubleshooting
Flowchart 2.1—Initial Troubleshooting
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Flowchart 2.2—No Power, Part 1
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Troubleshooting
Flowchart 2.3—No Power, Part 2
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Flowchart 2.4—No Power, Part 3
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Troubleshooting
Flowchart 2.5—No Power, Part 4
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Flowchart 2.6—No Video, Part 1
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Flowchart 2.7—No Video, Part 2

Y

N

Continued from
“Flowchart 2.6—No 

Video, Part 1.”

Done

Adjust external
monitor display.

Video OK?

Adjust
display

brightness.

Video OK?

Video OK?

Done

Done

Check that notebook is properly
seated in docking device,

for bent pins on cable,
and for monitor connection.

Go to “A” in
“Flowchart 2.6—No 

Video, Part 1.”

Check brightness
of external
monitor.

Try another
external
monitor.

Internal
and external
video OK?

Go to
“Flowchart 2.8—Non-
functioning Docking 

Device (if applicable).”

Y

Y

Y

N

N

N

Remove 
notebook from dock-

ing device, 
if connected.
Maintenance and Service Guide 2–15



Troubleshooting
Flowchart 2.8—Nonfunctioning Docking Device
(if applicable)
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Troubleshooting
Flowchart 2.9—No Operating System (OS) 
Loading
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Troubleshooting
Flowchart 2.10—No OS Loading, Hard Drive, 
Part 1
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Flowchart 2.11—No OS Loading, Hard Drive, 
Part 2
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Troubleshooting
Flowchart 2.12—No OS Loading, Hard Drive, 
Part 3
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Troubleshooting
Flowchart 2.13—No OS Loading, Diskette Drive
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Flowchart 2.14—No OS Loading, Optical Drive
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Troubleshooting
Flowchart 2.15—No Audio, Part 1
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Flowchart 2.16—No Audio, Part 2
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Flowchart 2.17—Nonfunctioning Device
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Flowchart 2.18—Nonfunctioning Keyboard
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Flowchart 2.19—Nonfunctioning Pointing 
Device
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Flowchart 2.20—No Network/Modem 
Connection
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3
Software Update and

Recovery

Software Updates
To stay current with the newest technology and maintain optimal 
performance, install the latest versions of HP software on your 
computer as they become available.

To update HP software:

1. Identify your computer model, product category, and series 
or family. Prepare for a system BIOS update by identifying 
the BIOS version currently installed on the computer.

Ä
CAUTION: If your computer is connected to a network, it is 
recommended that you consult with your network administrator before 
installing any software updates, especially system BIOS updates.

✎ The computer system BIOS is stored on the system ROM. The 
BIOS initializes the operating system, determines how the 
computer will interact with the hardware devices, and provides 
for data transfer among hardware devices, including the time 
and date.

2. Access the HP Web site at http://www.hp.com to obtain the 
updates or purchase the Support Software disc.

3. Install the updates.
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Accessing Computer Information
Before you access the updates for your computer, collect the 
following information:
■ The product category is Notebook.
■ The product family name and series number are printed on 

the display bezel.
■ Model information is provided on the serial number label on 

the bottom of the computer.
To determine whether available BIOS updates contain later BIOS 
versions than those currently installed on the computer, you need 
to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System 
BIOS) can be displayed by pressing fn+esc (if you are already in 
Microsoft Windows) or by opening Computer Setup.
To use Computer Setup for displaying BIOS information:

1. Open Computer Setup by turning on or restarting the 
computer, and then pressing f10 while the “F10 = ROM Based 
Setup” message is displayed in the lower-left corner of the 
screen.

2. Use the arrow keys to select File > System Information, and 
then press enter.
BIOS date information is displayed.

3. To exit Computer Setup, use the arrow keys to select File > 
Ignore changes and exit. Then follow the instructions on the 
screen.

Obtaining the Support Software Disc
The Support Software disc provides HP software updates and 
installation instructions. The disc includes device drivers, BIOS 
updates, and utilities.

To purchase the current Support Software disc or a subscription 
that provides both the current version and future versions of the 
disc, visit the HP Web site at http://www.hp.com.
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Software Updates and the 
HP Web Site

Most software on the HP Web site is packaged in compressed 
files called SoftPaqs. Some BIOS updates may be packaged in 
compressed files called ROMPaqs.

Most download packages contain a file named Readme.txt. 
A Readme.txt file contains information regarding installing and 
troubleshooting the file. The Readme.txt files included with 
ROMPaqs are provided in English only.

Downloading a BIOS Update

Ä
CAUTION: To prevent damage to the computer or an unsuccessful 
installation, download and install a BIOS update only when the computer 
is connected to reliable external power using the AC adapter. Do not 
download or install a BIOS update while the computer is running on 
battery power, docked in an optional docking device, or connected to an 
optional power source. During the download and installation:
■ Do not disconnect power from the computer by unplugging the 

power cord from the AC outlet.
■ Do not shut down the computer or initiate standby or hibernation.
■ Do not insert, remove, connect, or disconnect any device, cable, or 

cord.

To download a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

❏ Select Start > Help and Support, and then click a 
software update link.

– or –

❏ Visit the HP Web site at http://www.hp.com/support.

2. Follow the instructions on the screen to identify your 
computer and access the BIOS update you want to download.
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3. At the download area:

a. Identify the BIOS update that is later than the BIOS 
version currently installed on your computer. Make a note 
of the date, name, or other identifier. You may need this 
information to locate the update later, after it has been 
downloaded to your hard drive.

b. Follow the instructions on the screen to download your 
selection to the hard drive.

✎ Make a note of the path to the location on your hard drive 
where the BIOS update will be downloaded. You will need to 
access this path when you are ready to install the update.

Installing a BIOS Update

✎ If your computer is connected to a network, it is recommended 
that you consult with your network administrator before 
installing any software updates, especially system BIOS 
updates.

BIOS installation procedures vary. Follow any instructions that 
are displayed on the screen after the download is complete. If no 
instructions are displayed:

1. Open Windows Explorer by clicking Start > All
Programs > Accessories > Windows Explorer.

2. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation.

✎ The hard drive designation is typically Local Disk (C:).

b. Using the hard drive path you recorded earlier, open the 
folder on your hard drive that contains the update.
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3. Double-click the file with an .exe extension (for example, 
filename.exe).

The BIOS installation begins.

4. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you may delete the downloaded file from your hard drive.

Recovering the BIOS

✎ The BIOS recovery procedure requires a USB diskette drive 
and a formatted diskette.

The BIOS can be recovered if the flash memory is corrupted. 
Flash memory corruption can occur if the notebook powers down 
while the BIOS is being updated.

When the notebook is turned on, the boot block portion of the 
flash memory performs an integrity check on the rest of the BIOS 
image and enters recovery mode if the image is corrupt.

BIOS recovery can be forced on a non-functioning notebook by 
turning on the notebook while pressing and holding the Windows 
logo key + B on the nonfunctioning notebook keyboard until the 
caps lock light blinks.

To recover the BIOS:

1. If the nonfunctioning notebook is docked in an optional 
docking device, undock the notebook.

2. Attach the USB diskette drive directly to a USB port on the 
nonfunctioning notebook. (USB hubs are not supported for 
BIOS recovery).
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3. Insert the correct ROMPaq diskette for the product being 
updated. The BIOS image file must to be located in the root 
directory of the diskette and must be in contiguous sectors. 
The easiest way to ensure this is to visit http://www.hp.com, 
download the Softpaq, and let the Softpaq create the 
ROMPaq diskette.

4. Press and hold the Windows logo key + B on the notebook 
keyboard (do not use an external keyboard) and turn on the 
notebook and wait for the caps lock light to start blinking.

5. Release the Windows logo key + B.

The BIOS recovery procedure takes approximately one 
minute to read the image from the diskette, and then an 
additional 15 seconds to program the image into flash 
memory. The notebook restarts when the BIOS recovery 
procedure is complete. Do not attempt to turn off the 
notebook after starting a recovery.

If the BIOS recovery procedure stalls, the caps lock light will 
begin blinking. This situation can arise if the diskette is 
corrupt or the incorrect ROMPaq is used. If the notebook 
does not restart after approximately 3 minutes, press and hold 
the power button, or slide and hold the power switch, for at 
least 5 seconds to force the notebook to turn itself off. Then 
repeat the BIOS recovery procedure.
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4
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers.

4.1 Serial Number Location
When ordering parts or requesting information, provide the 
notebook serial number and model number located on the bottom 
of the notebook.

Serial Number Location
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4.2 Notebook Major Components

Notebook Major Components
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Table 4-1

Spare Parts: Notebook Major Components

Item Description
Spare Part 
Number

1 Display assemblies (include wireless antenna boards and cables)

15.0-inch, SXGA+WVA, TFT
15.0-inch, XGA, TFT
14.1-inch, XGA, TFT

395459-001
395458-001
395457-001

2 Switch cover 378232-001

3 LED board 378228-001

4 Keyboards

Korea
Taiwan

397243-AD1
397243-AB1

Thailand
United States

397243-281
397243-001

5 Fan 378233-001

6 Heat sink (includes thermal paste) 379799-001

7 Processors (include thermal paste)

Intel Pentium M 2.13-GHz
Intel Pentium M 2.00-GHz
Intel Pentium M 1.86-GHz
Intel Pentium M 1.73-GHz
Intel Pentium M 1.60-GHz
Intel Pentium M 1.30-GHz

378224-001
378223-001
378222-001
378221-001
378220-001
378219-001

Intel Celeron M 1.5-GHz
Intel Celeron M 1.4-GHz

378218-001
378217-001

8 Top cover (includes TouchPad) 395463-001
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Notebook Major Components
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Table 4-1

Spare Parts: Notebook Major Components (Continued)

Item Description
Spare Part 
Number

Miscellaneous Plastics Kit 378236-001

9a
9b

9c

Includes:
RTC battery
Memory module/Mini PCI compartment cover

(includes 1 captive screw)
Hard drive cover (includes 2 captive screws)
Not illustrated:

Notebook feet
PC Card slot space savers (2)

10 Modem board 325521-001

11 Memory modules (533-MHz DDR2)

1024 MB
512 MB
256 MB

373121-001
373120-001
373119-001

12 Speaker 378237-001

13 USB/audio board 378226-001

14 System boards

With 64 MB of video RAM
With 32 MB of video RAM

395461-001
395460-001

15 Digital media board 395462-001

16 Base enclosure 395464-001

17 Serial connector module 378227-001
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Notebook Major Components
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Table 4-1

Spare Parts: Notebook Major Components (Continued)

Item Description
Spare Part 
Number

18 Mini PCI communications cards

802.11b/g WLAN card, for use in most of the world
802.11b/g WLAN card, for use in the rest of the world

381582-001
381583-001

802.11a/b/g combination WLAN card, for use in the 
Asia Pacific region
802.11a/b/g combination WLAN card, for use in the 
rest of the world

373900-021

373901-002

19 Battery packs

6-cell, 4.8-AHr
6-cell, 4.8-AHr
8-cell, travel battery pack

372772-001
367457-001
367456-001

20 Optical drives (include bezel)

8X Max DVD-ROM drive
DVD/CD-RW Combo Drive
8X Max DVD±RW and CD-RW Combo Drive
8X Max DVD±RW and CD-RW Dual Layer Combo 
Drive, LightScribe

380770-001
380772-001
380773-001
397247-001

21 Broadcomm Bluetooth® wireless board (includes 
Bluetooth board cable)

367871-001

22 Hard drives (include frame and connector)

5400-rpm
80-GB
60-GB
40-GB

380108-001
378215-001
380107-001

4200-rpm, 60-GB 378213-001
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4.3 Miscellaneous Plastics Kit

Table 4-2

Miscellaneous Plastics Kit

Spare Part Number 378236-001

Item Description

1 Memory module/Mini PCI compartment cover
(includes 1 captive screw)

2 Hard drive cover (includes 2 captive screws)

3 RTC battery (includes cable)

4 Notebook feet (4)

5 PC Card slot space savers (2)
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4.4 Miscellaneous Cable Kit

Table 4-3

Miscellaneous Cable Kit

Spare Part Number 395465-001

Item Description

1 Bluetooth board cable

2 LED board cable

3 RJ-11 connector module and cable

4 Audio board cable

5 USB board cable

6 Serial connector module cable
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4.5 Mass Storage Devices

Table 4-4

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number

1 Hard drives (include frame and connector)

5400-rpm
80-GB
60-GB
40-GB

380108-001
378215-001
380107-001

4200-rpm
60-GB 378213-001

2 Optical drives (include bezel)

8X Max DVD-ROM drive
DVD/CD-RW Combo Drive
8X Max DVD±RW and CD-RW Combo Drive
8X Max DVD±RW and CD-RW Dual Layer Combo 
Drive, LightScribe

380770-001
380772-001
380773-001
397247-001
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4.6 Miscellaneous (Not Illustrated)

Table 4-5

Miscellaneous (Not Illustrated)

Spare Part Information

Description
Spare Part 
Number

65 watt AC adapter 239704-001

HP Advanced Docking Station 374804-001

HP Docking Station 374803-001

Docking Station Miscellaneous Plastics Kit 380089-001

Carrying cases

Nylon top-load

Nylon entry-level

325815-001
and
325815-002
325814-001

External MultiBay II 366143-001

External MultiBay II power cable and stand 366144-001

8-cell travel battery 367456-001

USB 1.1 diskette drive 359118-001

Power cords

For use in:

Canada, French Canada, Latin America, Taiwan, Thailand, 
and the United States

246959-001

Hong Kong and the United Kingdom 246959-031

Korea 246959-AD1

People’s Republic of China 246959-AA1
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Screw Kit (includes the following screws; refer to
Appendix C, “Screw Listing,” for more information on
specifications and usage

378235-001

■ Hex socket HM5.0×9.0 screw lock

■ Phillips PM2.5×13.0 spring-loaded 
screw

■ Phillips PM2.5×4.0 shoulder screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×8.0 shoulder screw

■ Phillips PM2.0×7.0 screw

■ Phillips PM2.0×4.0 screw

■ Phillips PM2.0×3.0 screw

■ Phillips PM1.5×4.0 screw

■ Phillips PM1.5×3.5 screw

■ Torx T8M2.0×9.0 screw

■ Torx T8M2.0×4.0 screw

■ Torx T8M2.0×2.0 screw

Table 4-5

Miscellaneous (Not Illustrated)

Spare Part Information (Continued)

Description
Spare Part 
Number
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4.7 Sequential Part Number Listing

Table 4-6

Sequential Part Number Listing

Spare Part 
Number Description

239704-001 65 watt AC adapter

246959-001 Power cord for use in Canada, French Canada, Latin America, 
Taiwan, Thailand, and the United States

246959-031 Power cord for use in Hong Kong and the United Kingdom

246959-AA1 Power cord for use in People’s Republic of China

246959-AD1 Power cord for use in Korea

325521-001 Modem board

325814-001 Nylon entry-level carrying case

325815-001 Nylon top-load carrying case

325815-002 Nylon top-load carrying case

359118-001 USB 1.1 diskette drive

366143-001 External MultiBay II

366144-001 External MultiBay II power cable and stand

367456-001 8-cell, travel battery pack

367457-001 6-cell, 4.8-AHr battery pack

367871-001 Broadcomm Bluetooth wireless board (includes Bluetooth 
board cable)

372772-001 6-cell, 4.8-AHr battery pack

373119-001 256-MB memory module (533-MHz DDR2)

373120-001 512-MB memory module (533-MHz DDR2)

373121-001 1024-MB memory module (533-MHz DDR2)
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373900-021 802.11a/b/g combination WLAN Mini PCI communications 
card, for use in the Asia Pacific region

373901-002 802.11a/b/g combination WLAN card, for use in the rest of 
the world

374803-001 HP Docking Station

374804-001 HP Advanced Docking Station

378213-001 4200-rpm, 60-GB hard drive (includes frame and connector)

378215-001 5400-rpm, 60-GB hard drive (includes frame and connector)

378217-001 Intel Celeron M 1.4-GHz processor (includes thermal paste)

378218-001 Intel Celeron M 1.5-GHz processor (includes thermal paste)

378219-001 Intel Pentium M 1.30-GHz processor (includes thermal paste)

378220-001 Intel Pentium M 1.60-GHz processor (includes thermal paste)

378221-001 Intel Pentium M 1.73-GHz processor (includes thermal paste)

378222-001 Intel Pentium M 1.86-GHz processor (includes thermal paste)

378223-001 Intel Pentium M 2.00-GHz processor (includes thermal paste)

378224-001 Intel Pentium M 2.13-GHz processor (includes thermal paste)

378226-001 USB/audio board

378227-001 Serial connector module

378228-001 LED board

378232-001 Switch cover

378233-001 Fan

378235-001 Screw Kit

378236-001 Miscellaneous Plastics Kit

Table 4-6

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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378237-001 Speaker

379799-001 Heat sink (includes thermal paste)

380089-001 Docking Station Miscellaneous Plastics Kit

380107-001 5400-rpm, 40-GB hard drive (includes frame and connector)

380108-001 5400-rpm, 80-GB hard drive (includes frame and connector)

380770-001 8X Max DVD-ROM drive (includes bezel)

380772-001 DVD/CD-RW Combo Drive (includes bezel)

380773-001 8X Max DVD±RW and CD-RW Combo Drive (includes bezel)

381582-001 802.11b/g WLAN Mini PCI communications card, for use in 
most of the world

381583-001 802.11b/g WLAN Mini PCI communications card, for use in 
the rest of the world

395457-001 14.1-inch, XGA, TFT display assembly (includes wireless 
antenna boards and cables)

395458-001 15.0-inch, XGA, TFT display assembly (includes wireless 
antenna boards and cables)

395459-001 15.0-inch, SXGA+WVA, TFT display assembly (includes 
wireless antenna boards and cables)

395460-001 System board with 32 MB of video RAM

395461-001 System board with 64 MB of video RAM

395462-001 Digital media board

395463-001 Top cover (include TouchPad)

395464-001 Base enclosure

395465-001 Miscellaneous Cable Kit

Table 4-6

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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397243-001 Keyboard for use in the United States

397243-281 Keyboard for use in Thailand

397243-AB1 Keyboard for use in Taiwan

397243-AD1 Keyboard for use in Korea

397247-001 8X Max DVD±RW and CD-RW Dual Layer Combo Drive, 
LightScribe (includes bezel)

Table 4-6

Sequential Part Number Listing (Continued)

Spare Part 
Number Description
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5
Removal and Replacement

Preliminaries

This chapter provides essential information for proper and 
safe removal and replacement service.

5.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:
■ Magnetic screwdriver
■ Phillips P0 screwdriver
■ 5.0-mm socket wrench for system board screw locks
■ Flat-bladed screwdriver
■ Tool kit—includes connector removal tool, loopback plugs, 

and case utility tool
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5.2 Service Considerations
The following sections include some of the considerations 
that you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the notebook, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the notebook, ensure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the notebook.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Ensure that cables are routed in such a way that 
they cannot be caught or snagged by parts being removed or 
replaced. Handle flex cables with extreme care; these cables 
tear easily.
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5.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the notebook, damage to a 
removable drive, or loss of information, observe the following 
precautions:
■ Before removing or inserting a hard drive, shut down the 

notebook. If you are unsure whether the notebook is off or 
in hibernation, turn the notebook on, and then shut it down 
through the operating system.

■ Before removing a diskette drive or optical drive, ensure that 
a diskette or disc is not in the drive and ensure that the optical 
drive tray is closed.

■ Before handling a drive, ensure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces covered with at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette 

drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic 

fields, such as monitors or speakers.
■ Avoid exposing a drive to temperature extremes or liquids.
■ If a drive must be mailed, place the drive in a bubble pack 

mailer or other suitable form of protective packaging and label 
the package “FRAGILE: Handle With Care.”
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5.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt 
silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge might not 
be affected at all and can work perfectly throughout a normal 
cycle. Or the device might function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.
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5.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:
■ To avoid hand contact, transport products in static-safe 

containers, such as tubes, bags, or boxes.
■ Protect all electrostatic-sensitive parts and assemblies with 

conductive or approved containers or packaging.
■ Keep electrostatic-sensitive parts in their containers until 

the parts arrive at static-free workstations.
■ Place items on a grounded surface before removing items 

from their containers.
■ Always be properly grounded when touching a sensitive 

component or assembly.
■ Store reusable electrostatic-sensitive parts from assemblies 

in protective packaging or nonconductive foam.
■ Use transporters and conveyors made of antistatic belts and 

roller bushings. Ensure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.
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5.6 Workstation Precautions
Use the following grounding precautions at workstations:
■ Cover the workstation with approved static-shielding material 

(refer to Table 5-2, “Static-Shielding Materials”).
■ Use a wrist strap connected to a properly grounded work 

surface and use properly grounded tools and equipment.
■ Use conductive field service tools, such as cutters, 

screwdrivers, and vacuums.
■ When fixtures must directly contact dissipative surfaces, use 

fixtures made only of static-safe materials.
■ Keep the work area free of nonconductive materials, such 

as ordinary plastic assembly aids and Styrofoam.
■ Handle electrostatic-sensitive components, parts, and 

assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting or removing 

connectors or test equipment.

5.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap at a grounded workstation.
■ When seated, wear a wrist strap connected to a grounded 

system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To provide 
proper ground, wear a strap snugly against the skin at all times. 
On grounded mats with banana-plug connectors, use alligator 
clips to connect a wrist strap.
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■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used at standing 
workstations and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, use 
foot straps on both feet with a minimum of one megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes:
■ Antistatic tape
■ Antistatic smocks, aprons, and sleeve protectors
■ Conductive bins and other assembly or soldering aids
■ Nonconductive foam
■ Conductive tabletop workstations with ground cords of 

one megohm resistance
■ Static-dissipative tables or floor mats with hard ties to 

the ground
■ Field service kits
■ Static awareness labels
■ Material-handling packages
■ Nonconductive plastic bags, tubes, or boxes
■ Metal tote boxes
■ Electrostatic voltage levels and protective materials
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Table 5-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 5-2 lists the shielding protection provided by antistatic 
bags and floor mats.

Table 5-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 V.

Table 5-2

Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Removal and Replacement

Procedures

This chapter provides removal and replacement procedures.

There are 64 screws and screw locks, in 11 different sizes, that 
must be removed, replaced, or loosened when servicing the 
notebook. Make special note of each screw and screw lock size 
and location during removal and replacement.

Refer to Appendix C, “Screw Listing,” for detailed information 
on screw and screw lock sizes, locations, and usage.
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6.1 Serial Number
Report the notebook serial number to HP when requesting 
information or ordering spare parts. The serial number is 
located on the bottom of the notebook.

Serial Number Location

6.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing notebook components.

Disassembly Sequence Chart

Section Description # of Screws Removed

6.3 Preparing the notebook for 
disassembly

Battery pack 0
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6.4 Hard drive 2 loosened to remove the 
hard drive cover

1 loosened to remove the 
hard drive

6 to disassemble the 
hard drive

6.5 Notebook feet 0

6.6 Bluetooth board 0

6.7 External memory module 1 loosened to remove the 
memory module/Mini PCI 
compartment cover

6.8 Mini PCI Communications Card 1 loosened to remove the 
memory module/Mini PCI 
compartment cover

Å To prevent an unresponsive system and the display of a 
warning message, install only a Mini PCI device authorized 
for use in your notebook by the governmental agency that 
regulates wireless devices in your country. If you install a 
device and then receive a warning message, remove the 
device to restore notebook functionality. Then contact 
Customer Care.

6.9 Optical drive 1

6.10 Keyboard 2

6.11 Switch cover 2

6.12 LED board 4

6.13 Fan 2 loosened

6.14 Heat sink 4 loosened

6.15 Processor 1 loosened

6.16 Internal memory module 0

6.17 RTC battery 0

6.18 Display assembly 6

Disassembly Sequence Chart (Continued)
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6.3 Preparing the Notebook for 
Disassembly
Before you begin any removal or installation procedures: 

1. Shut down the notebook. If you are unsure whether the 
notebook is off or in hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the notebook.

3. Disconnect the power cord.

6.19 Top cover 15

6.20 Speaker 6

6.21 Modem board 2

6.22 Digital media board 0

6.23 USB/audio board 1

6.24 System board 1 screw
4 screw locks

6.25 Serial connector module 2 screw locks

Disassembly Sequence Chart (Continued)

Battery Pack Spare Part Number Information

6-cell, 4.8-AHr
6-cell, 4.8-AHr
8-cell, travel battery pack

372772-001
367457-001
367456-001
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4. Remove the battery pack by following these steps:

a. Turn the notebook upside down with the rear panel 
toward you.

b. Slide and hold the battery pack lock latch 1 to the right.

c. Slide the battery pack release latch 2 to the right. (The 
battery pack disengages from the notebook.)

d. Slide the battery pack straight back 3 and remove it.

Removing the Battery Pack

Reverse the above procedure to install the battery pack.
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6.4 Hard Drive

1. Prepare the notebook for disassembly (refer to Section 6.3).

2. Loosen the two PM2.0×4.0 screws 1 that secure the hard 
drive cover to the notebook.

3. Lift the left side of the hard drive cover and swing it to 
the right 2.

4. Remove the hard drive cover.

✎ The hard drive cover is included in the Miscellaneous 
Plastics Kit, spare part number 378236-001.

Removing the Hard Drive Cover

Hard Drive Spare Part Number Information

5400-rpm
80-GB
60-GB
40-GB

380108-001
378215-001
380107-001

4200-rpm
60-GB 378213-001
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5. Loosen the PM2.5×13.0 spring-loaded hard drive retention 
screw 1.

6. Grasp the mylar tab 2 on the hard drive and slide the hard 
drive to the right 3 to disconnect it from the system board.

7. Remove the hard drive from the hard drive bay 4.

Removing the Hard Drive
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8. Remove the two PM2.5×4.0 hard drive frame shoulder 
screws 1 from each side of the hard drive.

9. Remove the two PM2.5×4.0 hard drive frame screws 2 from 
each side of the hard drive.

10. Remove the two PM1.5×3.5 hard drive frame screws 3 from 
the front of the hard drive.

11. Lift the frame straight up 4 to remove if from the hard drive.

12. Remove the hard drive connector 5 from the hard drive.

Removing the Hard Drive Frame and Connector

Reverse the above procedure to install and reassemble the 
hard drive.
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6.5 Notebook Feet
The notebook feet are adhesive-backed rubber pads. The feet are 
included in the Miscellaneous Plastics Kit, spare part number 
378236-001.

Replacing the Notebook Feet
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6.6 Bluetooth Board

1. Prepare the notebook for disassembly (refer to Section 6.3).

2. Remove the hard drive (Section 6.4).

Bluetooth Board Spare Part Number Information

Broadcomm Bluetooth wireless board (includes Bluetooth 
board cable)

367871-001
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3. Slide the Bluetooth board out of the clip 1 in the hard drive 
compartment.

4. Disconnect the Bluetooth board cable 2 from the board.

Removing the Bluetooth Board

Reverse the above procedure to install a Bluetooth board.
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6.7 External Memory Module

1. Prepare the notebook for disassembly (refer to Section 6.3).

2. Position the notebook with the front toward you.

3. Loosen the PM2.0×4.0 screw 1 that secures the memory 
module/Mini PCI compartment cover to the notebook.

4. Lift the rear edge of the cover up and swing it toward you 2.

5. Remove the memory module/Mini PCI compartment cover.

✎ The memory module/Mini PCI compartment cover is included 
in the Miscellaneous Plastics Kit, spare part number 
378236-001.

Removing the Memory Module/Mini PCI Compartment Cover

Memory Module Spare Part Number Information

1024 MB
512 MB
256 MB

373121-001
373120-001
373119-001
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6. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module board. (The 
edge of the module opposite the socket rises away from 
the notebook.)

7. Slide the module away from the socket at an angle 2.

8. Remove the memory module board.

✎ Memory modules are slotted 3 to prevent incorrect installation 
into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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6.8 Mini PCI Communications Card

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the memory module/Mini PCI compartment cover 
(Section 6.7).

3. Position the notebook with the front toward you.

Mini PCI Communications Card

Spare Part Number Information

802.11b/g WLAN card, for use in most of the world
802.11b/g WLAN card, for use in the rest of the world

381582-001
381583-001

802.11a/b/g combination WLAN card, for use in the Asia Pacific 
region
802.11a/b/g combination WLAN card, for use in the rest of 
the world

373900-021

373901-002
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4. Disconnect the auxiliary and main antenna cables 1 from the 
Mini PCI communications card.

✎ Make note of which antenna cable is attached to which antenna 
clip on the Mini PCI communications card before 
disconnecting the cables.

5. Spread the 2 retaining tabs 2 on each side of the Mini PCI 
socket to release the Mini PCI communications card. (The 
edge of the card opposite the socket rises away from the 
notebook.)

6. Remove the Mini PCI communications card by pulling the 
card away from the socket at a 45-degree angle 3.

✎ The Mini PCI communications card is slotted 4 to prevent 
incorrect installation.

Removing a Mini PCI Communications Card

Reverse the above procedure to install a Mini PCI 
communications card.
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6.9 Optical Drive

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the memory module/Mini PCI compartment cover 
(Section 6.7).

3. Position the notebook with the left side toward you.

Optical Drive Spare Part Number Information

8X Max DVD-ROM drive
DVD/CD-RW Combo Drive
8X Max DVD±RW and CD-RW Combo Drive
8X Max DVD±RW and CD-RW Dual Layer Combo Drive, 
LightScribe

380770-001
380772-001
380773-001
397247-001
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4. Remove the T8M2.0×9.0 screw 1 that secures the optical 
drive to the notebook.

5. Insert a thin tool, such as an unbent paper clip 2, into the 
media tray release hole and release the media tray.

6. Use the media tray to slide the optical drive to the left and out 
of the notebook 3.

7. Remove the optical drive.

Removing the Optical Drive

Reverse the above procedure to install an optical drive.
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6.10 Keyboard

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the memory module/Mini PCI compartment cover 
(Section 6.7).

3. Remove the two T8M2.0×9.0 screws that secure the keyboard 
to the notebook.

✎ The left keyboard retention screw is also used to secure the 
optical drive.

Removing the Keyboard Screws

Keyboard Spare Part Number Information

For use in Korea
For use in Taiwan

397243-AD1
397243-AB1

For use in Thailand
For use in the 
United States

397243-281
397243-001
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4. Turn the notebook display-side up with the front toward you.

5. Open the notebook as far as possible.

6. Slide the 4 keyboard retaining latches toward you.

Releasing the Keyboard Latches
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7. Lift the rear edge of the keyboard up and swing it toward you 
until it rests on the palm rest.

Releasing the Keyboard
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8. Release the zero insertion force (ZIF) connector 1 to which 
the keyboard cable is attached and disconnect the keyboard 
cable 2.

Disconnecting the Keyboard Cable

9. Remove the keyboard.

Reverse the above procedure to install the keyboard.
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Removal and Replacement Procedures
6.11 Switch Cover

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Close the notebook.

4. Turn the notebook upside down with the rear panel 
toward you.

5. Remove the two T8M2.0×2.0 screws that secure the switch 
cover to the notebook.

Removing the Switch Cover Screws

Switch Cover Spare Part Number Information

Switch cover 378232-001
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Removal and Replacement Procedures
6. Turn the notebook display-side up with front toward you.

7. Open the notebook as far as possible.

8. Disconnect the LED board cable 1 from the system board.

9. Insert a flat-bladed screwdriver into the four notches 2 on the 
front edge of the switch cover and lift up 3 until the cover 
disengages from the notebook.

10. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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Removal and Replacement Procedures
6.12 LED Board

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Remove the switch cover (Section 6.11).

4. Turn the notebook upside down with the rear panel 
toward you.

5. Turn the switch cover upside down.

LED Board Spare Part Number Information

LED board (includes LED board cable) 378228-001
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Removal and Replacement Procedures
6. Remove the four PM1.5×4.0 screws 1 that secure the LED 
board to the switch cover.

7. Remove the LED board 2.

Removing the LED Board

Reverse the above procedure to install the LED board.
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Removal and Replacement Procedures
6.13 Fan

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Disconnect the fan cable 1 from the system board.

4. Loosen the 2 PM2.0×7.0 screws 2 that secure the fan to the 
notebook.

5. Remove the fan 3.

Removing the Fan

Reverse the above procedure to install the fan.

Fan Spare Part Number Information

Fan 378233-001
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Removal and Replacement Procedures
6.14 Heat Sink

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Remove the fan (Section 6.13).

Heat Sink Spare Part Number Information

Heat sink (includes thermal paste) 379799-001
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Removal and Replacement Procedures
4. Loosen the four PM2.0×8.0 shoulder screws 1 that secure 
the heat sink to the notebook.

5. Lift the right side of the heat sink 2 to disengage it from the 
processor.

6. Slide the heat sink up and to the right 3 to remove it.

✎ Due to the adhesive quality of the thermal paste located 
between the heat sink and processor, it may be necessary to 
move the heat sink from side to side to detach the heat sink 
from the processor.

Removing the Heat Sink
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Removal and Replacement Procedures
✎ The thermal paste should be thoroughly cleaned from the 
surfaces of the heat sink 1 and processor 2 each time the heat 
sink is removed. Thermal paste should be reapplied to both 
surfaces before the heat sink is reinstalled. Thermal paste is 
included with all heat sink and processor spare part kits.

Replacing the Thermal Paste

Reverse the above procedure to install the heat sink.
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Removal and Replacement Procedures
6.15 Processor

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Remove the fan (Section 6.13).

4. Remove the heat sink (Section 6.14).

Processor Spare Part Number Information

Intel Pentium M 2.13-GHz
Intel Pentium M 2.00-GHz
Intel Pentium M 1.86-GHz
Intel Pentium M 1.73-GHz
Intel Pentium M 1.60-GHz
Intel Pentium M 1.30-GHz

378224-001
378223-001
378222-001
378221-001
378220-001
378219-001

Intel Celeron M 1.5-GHz
Intel Celeron M 1.4-GHz

378218-001
378217-001
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Removal and Replacement Procedures
5. Use a flat-bladed screwdriver to turn the processor locking 
screw one-quarter turn counterclockwise 1 until you hear 
a click.

6. Lift the processor straight up and remove it 2.

✎ The gold triangle 3 on the processor should be aligned in the 
front-right corner when you install the processor.

Removing the Processor

Reverse the above procedure to install the processor.
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Removal and Replacement Procedures
6.16 Internal Memory Module

1. Prepare the notebook for disassembly (Section 6.3).
2. Remove the keyboard (Section 6.10).

Memory Module Spare Part Number Information

1024 MB
512 MB
256 MB

373121-001
373120-001
373119-001
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Removal and Replacement Procedures
3. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module board. (The 
edge of the module opposite the socket rises away from 
the notebook.)

4. Slide the module away from the socket at an angle 2.

5. Remove the memory module board.

✎ Memory modules are slotted 3 to prevent incorrect installation 
into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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Removal and Replacement Procedures
6.17 RTC Battery

✎ The RTC battery is included in the Miscellaneous Plastics Kit, 
spare part number 378236-001.

1. Prepare the notebook for disassembly (Section 6.3).

2. Remove the keyboard (Section 6.10).

3. Disconnect the RTC battery cable 1 from the system board.

4. Remove the RTC battery 2 from the clip in the top cover.

Removing the RTC Battery

Reverse the above procedure to install an RTC battery.
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Removal and Replacement Procedures
6.18 Display Assembly

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

2. Disconnect the wireless antenna cables from the Mini PCI 
communications board (Section 6.8).

3. Turn the notebook display-side up with the front toward you.

4. Open the notebook as far as possible.

Display Assembly Spare Part Number Information

15.0-inch, SXGA+WVA, TFT
15.0-inch, XGA, TFT
14.1-inch, XGA, TFT

395459-001
395458-001
395457-001
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Removal and Replacement Procedures
5. Disconnect the display cable 1 from the system board.

6. Remove the wireless antenna cables from the Mini PCI 
compartment and the top cover clips 2.

7. Remove the two T8M2.0×9.0 screws 3 that secure the 
display assembly to the notebook.

Disconnecting the Display Cable and Removing the Display Screws
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Removal and Replacement Procedures
8. Swing the display assembly into a partially closed position.

9. Position the notebook with the rear panel toward you.

Ä
CAUTION: Support the display assembly when removing the following 
screws. Failure to support the display assembly can result in damage to 
the display assembly and other notebook components.

10. Remove the four T8M2.0×9.0 screws 1 that secure the 
display assembly to the notebook.

11. Lift the display assembly straight up and remove it 2.

Removing the Display Assembly

Reverse the above procedure to install the display assembly.
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Removal and Replacement Procedures
6.19 Top Cover

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

e. RTC battery (Section 6.17)

f. Display assembly (Section 6.18)

2. Turn the notebook upside down with the front toward you.

Top Cover Spare Part Number Information

Top cover (includes TouchPad) 395463-001
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Removal and Replacement Procedures
3. Remove the thirteen T8M2.0×9.0 screws that secure the top 
cover to the notebook.

Removing the Top Cover Screws, Part 1
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Removal and Replacement Procedures
4. Turn the notebook right-side up with the front toward you.

5. Remove the two T8M2.0×9.0 screws 1 that secure the top 
cover to the notebook.

6. Disconnect the TouchPad cable 2 from the system board.

Removing the Top Cover Screws, Part 2
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Removal and Replacement Procedures
7. Lift up the rear edge of the top cover 1 until it disengages 
from the base enclosure.

8. Swing the top cover toward you 2 until the left and right 
sides of the top cover disengage from the base enclosure.

9. Lift up on the left 3 and right sides 4 of the top cover until 
the top cover disengages from the base enclosure.

Releasing the Top Cover

10. Lift the top cover straight up until the front edge of the top 
cover disengages from the base enclosure and remove the top 
cover.

Reverse the above procedure to install the top cover.
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Removal and Replacement Procedures
6.20 Speaker

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

e. Display assembly (Section 6.18)

f. Top cover (Section 6.19)

2. Disconnect the speaker cable from the system board.

Disconnecting the Speaker Cable

Speaker Spare Part Number Information

Speaker 378237-001
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Removal and Replacement Procedures
3. Remove the six T8M2.0×4.0 screws 1 that secure the 
speaker to the notebook.

4. Lift the speaker up 2 until it clears the system board.

5. Slide the speaker toward you 3 and remove it.

Removing the Speaker

Reverse the above procedure to install the speaker.
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Removal and Replacement Procedures
6.21 Modem Board

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

e. Display assembly (Section 6.18)

f. Top cover (Section 6.19)

g. Speaker (Section 6.20)

Modem Board Spare Part Number Information

Modem board 325521-001
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Removal and Replacement Procedures
2. Remove the two PM2.0×3.0 screws 1 that secure the modem 
board to the notebook.

3. Lift the front edge of the modem board 2 to disconnect it 
from the system board.

4. Disconnect the modem cable 3 from the modem board.
5. Remove the modem board.

Removing the Modem Board

Reverse the above procedure to install the modem board.
Maintenance and Service Guide 6–45



Removal and Replacement Procedures
6.22 Digital Media Board

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

e. Display assembly (Section 6.18)

f. Top cover (Section 6.19)

g. Speaker (Section 6.20)

Digital Media Board Spare Part Number Information

Digital media board (includes digital media board cable) 395462-001
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Removal and Replacement Procedures
2. Release the ZIF connector to which the digital media board 
cable is attached and disconnect the digital media board 
cable 1 from the system board.

3. Remove the digital media board 2.

Removing the Digital Media Board

Reverse the above procedure to install the digital media board.
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Removal and Replacement Procedures
6.23 USB/Audio Board

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Memory module/Mini PCI compartment cover
(Section 6.7)

b. Optical drive (Section 6.9)

c. Keyboard (Section 6.10)

d. Switch cover (Section 6.11)

e. Display assembly (Section 6.18)

f. Top cover (Section 6.19)

USB/Audio Board Spare Part Number Information

USB/audio board 378226-001
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Removal and Replacement Procedures
2. Position the notebook with the rear panel toward you.

3. Disconnect the USB cable 1 and audio cable 2 from the 
system board.

4. Remove the PM1.5×3.0 screw 3 that secures the USB/audio 
board and shield to the base enclosure.

5. Remove the cables from the clips 4 in the base enclosure.

6. Remove the USB/audio board 5.

Removing the USB/Audio Board

Reverse the above procedure to install the USB/audio board.
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Removal and Replacement Procedures
6.24 System Board

✎ When replacing the system board, ensure that the following 
components are removed from the defective system board and 
installed on the replacement system board:
■ Memory modules (Section 6.7 and Section 6.16)
■ Mini PCI communications card (Section 6.8)
■ Processor (Section 6.15)
■ Modem board (Section 6.21)

System Board Spare Part Number Information

With 64 MB of video RAM
With 32 MB of video RAM

395461-001
395460-001
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Removal and Replacement Procedures
1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Hard drive (Section 6.4)

b. Bluetooth board (Section 6.6)

c. Optical drive (Section 6.9)

d. Keyboard (Section 6.10)

e. Switch cover (Section 6.11)

f. Fan (Section 6.13)

g. Heat sink (Section 6.14)

h. RTC battery (Section 6.17)

i. Display assembly (Section 6.18)

j. Top cover (Section 6.19)

k. Speaker (Section 6.20)

l. Digital media board (Section 6.22)

m. USB/audio board (Section 6.23)

2. Turn the notebook upside down with the rear panel 
toward you.
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Removal and Replacement Procedures
3. Disconnect the serial connector cable 1 and the Bluetooth 
cable 2 from the system board.

4. Remove the T8M2.0×4.0 screw 3 that secures the system 
board to the base enclosure next to the RJ-11 connector.

5. Remove the two HM5.0×9.0 screw locks 4 on each side of 
the parallel connector.

6. Remove the two HM5.0×9.0 screw locks 5 on each side of 
the external monitor connectors.

Removing the System Board Screws and Screw Locks
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Removal and Replacement Procedures
7. Use the optical drive connector to lift the system board up 1 
until the power connector 2 is clear of the base enclosure.

8. Slide the system board to the left 3 at an angle and remove it.

Removing the System Board
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Removal and Replacement Procedures
9. If necessary, disconnect the RJ-11 connector module cable 
from the system board and remove the RJ-11 connector 
module and cable.

Removing the RJ-11 Connector Module and Cable

Reverse the above procedures to install the system board.
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Removal and Replacement Procedures
6.25 Serial Connector Module

1. Prepare the notebook for disassembly (Section 6.3), 
and then remove the following components:

a. Hard drive (Section 6.4)

b. Bluetooth board (Section 6.6)

c. Optical drive (Section 6.9)

d. Keyboard (Section 6.10)

e. Switch cover (Section 6.11)

f. Fan (Section 6.13)

g. Heat sink (Section 6.14)

h. Modem board (Section 6.21)

i. Display assembly (Section 6.18)

j. Top cover (Section 6.19)

k. Speaker (Section 6.20)

l. Digital media board (Section 6.22)

m. USB/audio board (Section 6.23)

n. System board (Section 6.24)

2. Turn the base enclosure upside down with the rear panel 
toward you.

Serial Connector Module Spare Part Number Information

Serial connector module (includes serial connector 
module cable)

378227-001
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Removal and Replacement Procedures
3. Remove the two HM5.0×9.0 screw locks 1 on each side of 
the serial connector.

4. Lift the serial connector module and cable out of the base 
enclosure 2.

5. Disconnect the serial connector module cable from the 
system board 3.

Removing the Serial Connector Module

Reverse the above procedures to install the serial connector 
module.
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7
Specifications

This chapter provides physical and performance specifications.

Table 7-1

Notebook

Dimensions Metric U.S.

Height
Width
Depth

32.8 cm
26.7 cm
3.1 cm

12.91
10.51
1.22

Weight 2.66 kg 5.86 lbs

Input Power

Operating voltage
Operating current

18.5 V dc @ 3.5 A - 65 W
3.5 A

Temperature

Operating (not writing to 
optical disc)
Operating (writing to optical disc)
Nonoperating

0°C to 35°C

5°C to 35°C
-20°C to 60°C

32°F to 95°F

41°F to 95°F
-4°F to 140°F

Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%

10% to 90%
5% to 95%
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Specifications
Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)
Nonoperating (14.7 to 4.4 psia)

-15 m to 3,048 m
-15 m to 12,192 m

-50 ft to 10,000 ft
-50 ft to 40,000 ft

Shock

Operating
Nonoperating

125 g, 2 ms, half-sine
200 g, 2 ms, half-sine

Random Vibration

Operating

Nonoperating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 
0.25 oct/min sweep rate
1.50 g zero-to-peak, 10 Hz to 500 Hz, 
0.5 oct/min sweep rate

✎ Applicable product safety standards specify thermal limits for plastic 
surfaces. The notebook operates well within this range of temperatures.

Table 7-1

Notebook (Continued)
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Specifications
Table 7-2

15.0-inch, SXGA+WVA, TFT Display

Dimensions

Height
Width
Diagonal

30.0 cm
22.9 cm
38.1 cm

11.8 in
9.0 in
15.0 in

Number of colors Up to 16.8 million

Contrast ratio 300:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.264 × 0.264 mm
1400 × 1050
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 5.5 W

Viewing angle +/-35° horizontal, +15/-35° vertical 
typical
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Specifications
Table 7-3

15.0-inch, XGA, TFT Display

Dimensions

Height
Width
Diagonal

30.0 cm
22.9 cm
38.1 cm

11.8 in
9.0 in
15.0 in

Number of colors Up to 16.8 million

Contrast ratio 250:1

Brightness 150 nits typical

Pixel resolution

Pitch
Format
Configuration

0.264 × 0.264 mm
1024 × 768
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 5.5 W

Viewing angle +/-35° horizontal, +15/-35° vertical 
typical
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Specifications
Table 7-4

14.1-inch, XGA, TFT Display

Dimensions

Height
Width
Diagonal

28.5 cm
21.3 cm
35.8 cm

11.2 in
8.4 in
14.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1

Brightness 150 nits typical

Pixel resolution

Pitch
Format
Configuration

0.279 × 0.279 mm
1024 × 768
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40° horizontal, +20/-40° vertical 
typical
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Specifications
Table 7-5

Hard Drives

80-GB* 60-GB* 60-GB* 40-GB*

Dimensions

Height
Width
Weight

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type ATA-6 ATA-6 ATA-6 ATA-6

Transfer rate

Synchronous 
(maximum)
Security

100 MB/sec

ATA security

100 MB/sec

ATA security

100 MB/sec

ATA security

100 MB/sec

ATA security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 156,301,488 117,210,240 117,210,240 76,140,160

Disc rotational 
speed

5400 rpm 5400 rpm 4200 rpm 5400 rpm

Operating 
temperature

5°C to 55°C (41°F to 131°F)

✎  Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual 
accessible capacity is less.
†Actual drive specifications may differ slightly.
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Specifications
Table 7-6

Primary 6-cell, Li-Ion Battery Pack

Dimensions

Height
Width
Depth
Weight

2.00 cm
5.30 cm
20.30 cm
0.34 kg

0.79 in
2.10 in
8.00 in
0.74 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

10.8 V
4.8 Ah
51 Wh

Temperature

Operating
Nonoperating

0°C to 45°C
-20°C to 60°C

32°F to 113°F
-4°F to 140°F
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Specifications
Table 7-7

DVD-ROM Drive

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18)
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, Form 1 and 2)
CD-I ready (Mode 2, Form 1 and 2)
CD-R
CD-RW
Photo CD (single and multisession)
CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 100 ms
< 175 ms

< 125 ms
< 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

3600 KB/s (150 KB/s at 1X CD rate)
1500 KB/s (150 KB/s at 1X CD rate)
3600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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Specifications
Table 7-8

DVD/CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, 
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18),
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, 
Form 1 and 2)
CD-I ready (Mode 2, 
Form 1 and 2)
CD-R, CD-RW
Photo CD (single and 
multisession)
CD-Bridge

Write:
CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD media DVD media

Random
Full stroke

< 110 ms
< 210 ms

< 130 ms
< 225 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 2 MB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

3600 KB/s (150 KB/s at 1X CD rate)
1500 KB/s (150 KB/s at 1X CD rate)
3600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 7-8

DVD/CD-RW Combo Drive (Continued)
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Specifications
Table 7-9

DVD±RW and CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, 
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18),
CD-ROM (Mode 1 
and 2)
CD Digital Audio
CD-XA ready (Mode 
2, Form 1 and 2)
CD-I ready (Mode 2, 
Form 1 and 2)
CD-R, CD-RW
Photo CD (single 
and multisession)
CD-Bridge

Write:
CD-R and CD-RW
DVD-R and 
DVD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output level Audio-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 7-9

DVD±RW and CD-RW Combo Drive (Continued)
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Specifications
Table 7-10

System DMA

Hardware DMA System Function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 SMC IrCC - Fast Infrared Port

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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Specifications
Table 7-11

System Interrupts

IRQ System Function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural Keyboard

IRQ2 Cascaded

IRQ3 SMC IrCC - Fast Infrared Port

IRQ4 COM1

IRQ5* Not assigned

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Mobile Intel 915GM/PM Express PCI Express Root Port - 2591
Intel 82801FB/FBM USB Universal Host Controller - 2658
Intel 82801FB/FBM USB Universal Host Controller - 265B
Intel 82801FB/FBM USB2 Enhanced Host Controller - 265C
Intel 82801FB/FBM PCI Express Root Port - 2660
ATI MOBILILITY RADEON X300
SDA Standard Compliant Secure Digital Host Controller
TI OHCI Compliant IEEE 1394 Host Controller
TI PCI GemCore based SmartCard Controller
TI PCIxx21 Integrated FlashMedia Controller
TI PCIxx21/x515 Cardbus controller
Agere System AC '97 Modem
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Specifications
IRQ11* Intel 82801FB/FBM USB Universal Host Controller - 2659
Intel 82801FB/FBM USB Universal Host Controller - 265A
Broadcom NetXtreme Gigabit Ethernet #2
SoundMAX Integrated Digital Audio

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15* Not assigned

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, 
IRQ10, or none.

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or 
IRQ15. Either the infrared or the serial port may assert IRQ3 or IRQ4.

Table 7-11

System Interrupts (Continued)

Table 7-12

System I/O Addresses

I/O Address (hex) System Function (shipping configuration)

000 - 00F DMA controller no.1

010 - 01F System board resources

020 - 021 Interrupt controller no.1

022 - 023 Unused

024 - 03F System board resources

040 - 043 System timer

044 - 04D Unused

04E - 04F System board resources

050 - 053 System board resources
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Specifications
I/O Address (hex) System Function (shipping configuration)

054 - 059 Unused

060 Keyboard controller

061 System speaker

062 MS ACPI-Compliant embedded controller

063 System board resources

064 Keyboard controller

065 System board resources

066 MS ACPI-Compliant embedded controller

067 System board resources

068 Unused

070 - 071 RTC/CMOS

072 - 073 RTC/CMOS

074 - 077 Motherboard resources

078 - 079 Unused

080 - 08F DMA page registers

090 - 09F System board resources

0A0 - 0A1 Interrupt controller no.2

0A2 - 0A3 Unused

0A4 - 0BD System board resources

0BE - 0BF Unused

0C0 - 0DF DMA controller 2

0E0 - 0EF Unused

0F0 - 0FF Numeric data processor

Table 7-12

System I/O Addresses (Continued)
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Specifications
I/O Address (hex) System Function (shipping configuration)

100 - 10F SMC IrCC - Fast Infrared Port

110 - 1EF Unused

1F0 - 1F7 Primary IDE channel

1F8 - 377 Unused

378 - 37F Parallel port (LPT1/default)

380 - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Unused

3C0 - 3DF VGA

3E0 - 3E7 Unused

3E8 - 3EF SMC IrCC - Fast infrared port

3F0 - 3F5 Unused

3F6 Primary IDE channel

3F7 Unused

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register

CFC - CFF PCI configuration data register

Table 7-12

System I/O Addresses (Continued)
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Specifications
Table 7-13

System Memory Map

Size Memory Address System Function

640 KB 00000000 - 0009FFFF Base memory

128 KB 000A0000 - 000BFFFF Video memory

128 KB 000C0000 - 000DFFFF Video BIOS and other Optional ROM

128 KB 000E0000 - 000FFFFF System BIOS

2047 MB 00010000 - 7FFFFFFF Extended memory

1 GB 80000000 - BFFFFFFF PCI Bus

32 MB C0000000 - C1FFFFFF Video memory (direct access)

991 MB C2000000 - FFF00000 PCI Bus

1 MB FFF00000 - FFFFFFFF System BIOS
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A
Connector Pin Assignments

Table A-1

Audio-Out (Headphone)

Pin Signal Pin Signal

1 Audio out, left channel 3 Ground

2 Audio out, right channel
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Connector Pin Assignments
Table A-2

Audio-In (Microphone)

Pin Signal Pin Signal

1 Audio signal in 3 Ground

2 Audio signal in

Table A-3

Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
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Connector Pin Assignments
Table A-4

Serial

Pin Signal Pin Signal

1 Carrier detect 6 Data set ready

2 Receive data 7 Ready to send

3 Transmit data 8 Clear to send

4 Data terminal ready 9 Ring indicator

5 Ground
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Connector Pin Assignments
Table A-5

Parallel Port

Pin Signal Pin Signal

1 Strobe 14 Auto linefeed

2 Data bit 0 15 Error

3 Data bit 1 16 Initialize printer

4 Data bit 2 17 Select in

5 Data bit 3 18 Ground

6 Data bit 4 19 Ground

7 Data bit 5 20 Ground

8 Data bit 6 21 Ground

9 Data bit 7 22 Ground

10 Acknowledge 23 Ground

11 Busy 24 Ground

12 Paper end 25 Ground

13 Select Ground
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Connector Pin Assignments
Table A-6

7-Pin S-Video-Out

Pin Signal Pin Signal

1 C (chrominance) 5 Composite video

2 Ground 6 Unused

3 Y (luminance) 7 Ground

4 Ground
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Connector Pin Assignments
Table A-7

External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Connector Pin Assignments
Table A-8

RJ-11 (Modem)

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused
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Connector Pin Assignments
Table A-9

RJ-45 (Network)

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
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B
Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the notebook permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the notebook meets the 
requirements for use in the country where the equipment 
is purchased.

Power cord sets for use in other countries must meet the 
requirements of the country where the notebook is used.
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Power Cord Set Requirements
General Requirements
The requirements listed below are applicable to all countries.

■ The length of the power cord set must be at least 1.5 m 
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the 
country where the power cord set will be used.

■ The power cord sets must have a minimum current capacity 
of 10 amps and a nominal voltage rating of 125 or 250 V AC, 
as required by each country’s power system.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the notebook.
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Power Cord Set Requirements
Country-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.
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Power Cord Set Requirements
Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

People’s Republic 
of China

CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

United Kingdom BSI 1

United States UL 2

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country 
where it will be used.

5. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country 
where it will be used.

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
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C
 Screw Listing

This appendix provides specification and reference information 
for the screws and screw locks used in the notebook. All screws 
and screw locks listed in this appendix are available in the 
Screw Kit, spare part number 378235-001.
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Screw Listing
Phillips PM2.0×4.0 Screw Locations

Table C-1

Phillips PM2.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 3 4.0 mm 2.0 mm 4.0 mm

Where used:
1 One screw that secures the memory module/Mini PCI compartment cover 
to the notebook (screw is captured on the cover by a C clip; documented in 
Section 6.7)
2 Two screws that secure the hard drive cover to the notebook (screws are 
captured on the cover by C clips; documented in Section 6.4)

mm
C–2 Maintenance and Service Guide



Screw Listing
Phillips PM2.5×13.0 Screw Location

Table C-2

Phillips PM2.5×13.0 Spring-Loaded

Hard Drive Retention Screw

Color Qty. Length Thread
Head 
Width

Silver 1 13.0 mm 2.5 mm 5.5 mm

Where used:
One screw that secures the hard drive to the notebook (screw is captured on the 
hard drive frame by a C clip; documented in Section 6.4)

mm
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Screw Listing
Phillips PM2.5×4.0 Shoulder Screw, Phillips PM2.5×4.0 Screw, 
and Phillips PM1.5×3.5 Screw Locations

Table C-3

Phillips PM2.5×4.0 Shoulder Screw, Phillips PM2.5×4.0 Screw,

and Phillips PM1.5×3.5 Screw 

Color Qty. Length Thread
Head 
Width

Silver 2 4.0 mm 2.5 mm 4.0 mm

Color Qty. Length Thread
Head 
Width

Silver 2 4.0 mm 2.5 mm 4.5 mm

Color Qty. Length Thread
Head 
Width

Black 2 3.5 mm 1.5 mm 4.5 mm

Where used:
1 Two shoulder screws that secure the hard drive frame to the hard drive 
(documented in Section 6.4)
2 Two screws that secure the hard drive frame to the hard drive (documented 
in Section 6.4)
3 Two screws that secure the hard drive frame to the hard drive (documented 
in Section 6.4)

mm

mm

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Location

Table C-4

Torx T8M2.0×9.0 Screw

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the optical drive to the notebook (documented in 
Section 6.9)

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Locations

Table C-4

Torx T8M2.0×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the keyboard to the notebook (documented in
Section 6.10)

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Locations

Table C-4

Torx T8M2.0×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the display assembly to the notebook (documented in 
Section 6.18)

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Locations

Table C-4

Torx T8M2.0×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the display assembly to the notebook (documented in 
Section 6.18)

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Locations

Table C-4

Torx T8M2.0×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
13 screws that secure the top cover to the notebook (documented in
Section 6.19)

mm
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Screw Listing
Torx T8M2.0×9.0 Screw Locations

Table C-4

Torx T8M2.0×9.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 24 9.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the top cover to the notebook (documented in
Section 6.19)

mm
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Screw Listing
Torx T8M2.0×2.0 Screw Locations

Table C-5

Torx T8M2.0×2.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 2.0 mm 2.0 mm 6.0 mm

Where used:
2 screws that secure the switch cover to the notebook (documented in
Section 6.11)

mm
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Screw Listing
Phillips PM1.5×4.0 Screw Locations

Table C-6

Phillips PM1.5×4.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 4.0 mm 1.5 mm 4.0 mm

Where used:
4 screws that secure the LED board to the switch cover (documented in
Section 6.12)

mm
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Screw Listing
Phillips PM2.0×7.0 Screw Locations

Table C-7

Phillips PM2.0×7.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 7.0 mm 2.0 mm 4.5 mm

Where used:
2 screws that secure the fan to the notebook (screws are captured on the fan 
assembly by an O clip; documented in Section 6.13)

mm
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Screw Listing
Phillips PM2.0×8.0 Shoulder Screw Locations

Table C-8

Phillips PM2.0×8.0 Shoulder Screw

Color Qty. Length Thread
Head 
Width

Silver 4 8.0 mm 2.0 mm 5.0 mm

Where used:
4 screws that secure the heat sink to the notebook (screws are captured on the 
heat sink by C clips; documented in Section 6.14)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table C-9

Phillips PM2.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 2 3.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the modem board to the notebook (documented in
Section 6.21)

mm
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Screw Listing
Torx T8M2.0×4.0 Screw Locations

Table C-10

Torx T8M2.0×4.0 Screw

Color Qty. Length Thread
Head 
Width

Black 8 4.0 mm 2.0 mm 4.0 mm

Where used:
6 screws that secure the speaker to the notebook (documented in Section 6.20)

mm
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Screw Listing
Torx T8M2.0×4.0 Screw Location

Table C-10

Torx T8M2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 4.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the USB/audio board the notebook (documented in 
Section 6.23)

mm
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Screw Listing
Torx T8M2.0×4.0 Screw Location

Table C-10

Torx T8M2.0×4.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 8 4.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the system board the notebook (documented in
Section 6.24)

mm
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Screw Listing
Hex Socket HM5.0×9.0 Screw Lock Locations

Table C-11

Hex Socket HM5.0×9.0 Screw Lock

Color Qty. Length Thread
Head 
Width

Silver 6 9.0 mm 2.5 mm 5.0 mm

Where used:
1 Two screw locks that secure the system board to the notebook (documented 
in Section 6.24)
2 Two screw locks that secure the system board to the notebook (documented 
in Section 6.24)

mm
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Screw Listing
Hex Socket HM5.0×9.0 Screw Lock Locations

Table C-11

Hex Socket HM5.0×9.0 Screw Lock (Continued)

Color Qty. Length Thread
Head 
Width

Silver 6 9.0 mm 2.5 mm 5.0 mm

Where used:
2 screw locks that secure the serial connector board to the system board 
(documented in Section 6.25)

mm
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Index

1394 port 1–11
6-in-1 Digital Media Slot 1–7
6-in-1 Digital Media Slot light 

1–7

A
AC adapter, spare part 

numbers 4–11, 4–13
arrow keys 1–15
audio board

removal 6–48
spare part number 6–48

audio board cable 4–9
audio troubleshooting 2–23
audio-in jack

location 1–9
pin assignments A–2

audio-out jack
location 1–9
pin assignments A–1

B
base enclosure, spare part 

number 4–5, 4–15
battery bay 1–13, 1–20
battery light 1–7
battery locking latch 1–20

battery pack
removal 6–5
spare part numbers 4–7, 

4–13
specifications 7–7

battery release latch 1–21
Bluetooth board

removal 6–10
spare part number 4–7, 

4–13, 6–10
Bluetooth board cable 4–9
bottom components 1–20

C
cables, service considerations 

5–2
caps lock key 1–15
caps lock light 1–17
components

bottom 1–20
front 1–6
keyboard 1–12, 1–14
left-side 1–10
rear 1–10
right-side 1–8
top 1–16, 1–18
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Index
Computer Setup
Advanced Menu 2–6
File Menu 2–3
overview 2–1
Security Menu 2–4
Tools Menu 2–5

Computer Setup defaults 2–2
connector pin assignments

audio-in A–2
audio-out A–1
external monitor A–6
headphone A–1
microphone A–2
modem A–7
monitor A–6
network A–8
parallel A–4
RJ-11 A–7
RJ-45 A–8
serial A–3
S-Video-out A–5
Universal Serial Bus (USB) 

A–2
connectors, service 

considerations 5–2

D
design overview 1–22
digital media board

removal 6–46
spare part number 4–5, 

4–15, 6–46
Digital Media Slot light, 6-in-1 

1–7
Digital Media Slot, 6-in-1 1–7

disassembly sequence chart 
6–2

diskette drive
OS loading problems 2–21
precautions 5–3

display assembly
removal 6–35
spare part numbers 4–3, 

4–15, 6–35
specifications 7–3, 7–4, 

7–5
display lid switch 1–17
display release button 1–6
docking connector 1–20
docking device

spare part number 4–11, 
4–14

troubleshooting 2–16
docking station, spare part 

number 4–11, 4–14
drives, preventing damage 5–3
DVD/CD-RW Combo Drive

OS loading problems 2–17
precautions 5–3
removal 6–16
spare part number 4–7, 

4–10, 4–15, 6–16
specifications 7–9

DVD±RW and CD-RW 
Combo Drive

OS loading problems 2–17
precautions 5–3
removal 6–16
spare part number 4–7, 

4–10, 4–15, 4–16, 6–16
specifications 7–11
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Index
DVD-ROM drive
OS loading problems 2–17
precautions 5–3
removal 6–16
spare part number 4–7, 

4–10, 4–15, 6–16
specifications 7–8

E
electrostatic discharge 5–4, 

5–8
exhaust vents 1–11
external monitor port

location 1–10
pin assignments A–6

External MultiBay II, spare 
part number 4–11, 4–13

F
f1 to f12 keys 1–15
fan

location 1–21
removal 6–26
spare part number 4–3, 

4–14, 6–26
features 1–2
feet

illustrated 4–8
locations 6–9

flowcharts, troubleshooting
no audio 2–23, 2–24
no network/modem 

connection 2–28
no OS loading 2–17
no OS loading from 

diskette drive 2–21

no OS loading from hard 
drive 2–18, 2–19, 2–20

no OS loading from optical 
drive 2–22

no power 2–10, 2–12, 2–13
no video 2–14, 2–15
nonfunctioning device 

2–25
nonfunctioning docking 

device 2–16
nonfunctioning keyboard 

2–26
nonfunctioning pointing 

device 2–27
fn key 1–15
front components 1–6

G
grounding equipment and 

methods 5–6

H
hard drive

OS loading problems 2–18
precautions 5–3
removal 6–6
spare part numbers 4–7, 

4–10, 4–14, 4–15, 6–6
specifications 7–6

hard drive bay 1–21
hard drive cover

illustrated 4–8
removal 6–6

hard drive light 1–7
headphone jack

location 1–9
pin assignments A–1
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Index
heat sink
removal 6–27
spare part number 4–3, 

4–15, 6–27

I
I/O address specifications 

7–15
Info Center button 1–17
infrared port 1–6
interrupt specifications 7–14

K
keyboard

removal 6–18
spare part numbers 4–3, 

4–16, 6–18
troubleshooting 2–26

keyboard components 1–12, 
1–14

keypad keys 1–15

L
LED board

removal 6–24
spare part number 4–3, 

4–14, 6–24
LED board cable 4–9
left-side components 1–10

M
mass storage devices, spare 

part numbers 4–10
memory map specifications 

7–18
memory module

removal 6–12, 6–32

spare part numbers 4–5, 
4–13, 6–12, 6–32

memory module compartment 
1–21

memory module/Mini PCI 
compartment cover

illustrated 4–8
removal 6–12

microphone jack
location 1–9
pin assignments A–2

Mini PCI communications 
card

removal 6–14
spare part numbers 4–7, 

4–14, 4–15
Mini PCI compartment 1–21
Miscellaneous Cable Kit

components 4–9
spare part number 4–9, 

4–15
Miscellaneous Plastics Kit

components 4–5, 4–8, 
4–14

spare part number 4–5, 
4–8, 4–14

Miscellaneous Plastics Kit (for 
use with docking station), 
spare part number 4–11, 
4–15

modem board
removal 6–44
spare part number 4–5, 

4–13, 6–44
Index–4 Maintenance and Service Guide



Index
modem cable
illustrated 4–9
removal 6–54

modem jack
location 1–11
pin assignments A–7

modem, troubleshooting 2–28
monitor port

location 1–10
pin assignments A–6

N
network jack

location 1–11
pin assignments A–8

network, troubleshooting 2–28
nonfunctioning device, 

troubleshooting 2–16, 2–25
notebook feet

illustrated 4–8
locations 6–9

notebook specifications 7–1
num lock key 1–15
num lock light 1–17

O
optical drive

location 1–9
OS loading problems 2–22
precautions 5–3
removal 6–16
spare part numbers 4–7, 

6–16
specifications 7–8, 7–9, 

7–11

P
packing precautions 5–5
parallel port

location 1–13
pin assignments A–4

PC Card eject buttons 1–11
PC Card slot space saver 4–8
PC Card slots 1–11
plastic parts 5–2
pointing device, 

troubleshooting 2–27
power connector 1–13
power cord

set requirements B–2
spare part numbers 4–11, 

4–13
power management features 

1–5
power, troubleshooting 2–10
power/standby button 1–16
power/standby light 1–6
Presentation mode button 

1–17
processor

removal 6–30
spare part numbers 4–3, 

4–14, 6–30

R
rear components 1–10
removal/replacement

preliminaries 5–1
procedures 6–1

right-side components 1–8
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Index
RJ-11 connector module and 
cable

illustrated 4–9
removal 6–54

RJ-11 jack
location 1–11
pin assignments A–7

RJ-45 jack
location 1–11
pin assignments A–8

RTC battery
illustrated 4–8
removal 6–34

S
Screw Kit

contents C–1
spare part number 4–12, 

4–14, C–1
screw listing C–1
security cable slot 1–13
serial connector module

removal 6–55
spare part number 4–5, 

4–14, 6–55
serial connector module cable, 

illustrated 4–9
serial number 4–1, 6–2
serial port

location 1–9
pin assignments A–3

service considerations 5–2
speaker

removal 6–42
spare part number 4–5, 

4–15, 6–42

speakers, location 1–6
specifications

battery pack 7–7
display 7–3, 7–4, 7–5
DVD/CD-RW Combo 

Drive 7–9
DVD±RW and CD-RW 

Combo Drive 7–11
DVD-ROM drive 7–8
hard drive 7–6
I/O addresses 7–15
interrupts 7–14
memory map 7–18
notebook 7–1
optical drive 7–8, 7–9, 

7–11
system DMA 7–13

static shielding materials 5–8
S-Video-out jack

location 1–13
pin assignments A–5

switch cover
removal 6–22
spare part number 4–3, 

4–14
spare part numbers 6–22

system board
removal 6–50
spare part numbers 4–5, 

4–15, 6–50
system DMA 7–13
system memory map 7–18

T
tools required 5–1
top components 1–16, 1–18
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top cover
removal 6–38
spare part number 4–3, 

4–15, 6–38
TouchPad 1–19
TouchPad buttons 1–19
TouchPad scroll zone 1–19
transporting precautions 5–5
travel battery connector 1–21
travel battery pack, spare part 

number 4–11, 4–13
troubleshooting

audio 2–23
Computer Setup 2–2
docking device 2–16
flowcharts 2–7
keyboard 2–26
modem 2–28
network 2–28
nonfunctioning device 

2–16, 2–25
OS loading 2–17
overview 2–1
pointing device 2–27
power 2–10
video 2–14

U
Universal Serial Bus (USB) 

board cable 4–9
Universal Serial Bus (USB) 

diskette drive, spare part 
number 4–11, 4–13

Universal Serial Bus (USB) 
port

location 1–9, 1–10
pin assignments A–2

USB/audio board
removal 6–48
spare part number 4–5, 

4–14, 6–48

V
video troubleshooting 2–14
volume buttons 1–19

W
Windows applications key 

1–15
Windows logo key 1–15
wireless button 1–17
wireless light 1–6, 1–17
workstation precautions 5–6
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